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Chapter 7
How To Use Aquarius

This chapter  describes how to use Aquarius including how to: 1) build a flow network using the
graphical user interface, 2) enter the necessary physical and economic data, 3) solve the water
allocation problem, and 4) view model outputs. We assume that the user is familiar with basic
procedures for running applications in a Windows environment such as choosing commands and
resizing windows. Aquarius requires a personal computer with a Pentium-type processor and a 32-
bit operating system (Microsoft Windows 98, NT, 2000, XP). Enhanced performance is attained
using a system with a high number crunching capability.

Exploring the Network Worksheet Screen

As described in Chapter 6, Aquarius was written using an object-oriented programming language.
Each water system component is an object of the model, and each tool is a function that operates on
an object. Although the object terminology is not repeated in this chapter, remember that the object
structure of the model is what allows users to easily create a unique flow network composed of a set
of water system components (WSC).

Network Worksheet (NWS) Screen

Once the Aquarius software is loaded in the computer, the application is launched by double-
clicking the Aquarius icon. Initially a shortened menu selection is displayed with options for
creating a new flow network or for opening an existing one by selecting the File menu. Then, the
Aquarius screen and NWS appear (figure 7.1).

The NWS can be resized and scrolled. Several flow networks can be displayed simultaneously,
although only one NWS at a time is active. The title bar at the top of the NWS indicates the name
of the flow network, which should have the file extension “.nwk”. The menu bar at the top of the
screen provides access to the various Aquarius commands. The two palettes contain the WSCs
(upper side) and tools (left side) used to create the flow networks, as described later. At the bottom
of the screen is the status line, which provides information on the currently selected object or
procedure.

Menu Bar

Pull-down menus are arranged at the top of the screen as shown in figure 7.1. Each menu has sub-
menus that allow the user to access the functions available in the model once a NWS is loaded. The
complete layout of the pull-down menu bar is in figure 7.2. The command functions are explained
throughout this chapter.
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Figure 7.1  Aquarius (V05) network worksheet screen .

Water System Components (WSC) Palette

The WSC that make up a flow network are a series of nodes and links. All WSC are in a palette that
is automatically displayed on the upper side of the screen. The user can move the WSC palette any
place on the screen including the four boundaries. The WSC palette can be removed from the screen
by disabling the palette from the View menu. Choosing the WSC palette again returns it to its default
position. The icons, names, and functions of the WSC are in table 7.1.
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Figure 7.2  Aquarius (V05) pull-down menus. 
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Table 7.1   The water system components palette.
        Button Name and function
 
        Surface Water: creates a surface water supply source

(catchment) contributing uncontrolled flows.

        Ground Water: creates a subsurface water supply source
(aquifer) contributing controlled flows 

        Storage Reservoir: creates a water storage capacity for
flow regulation.

        Release-to-downstream-demand: creates a pseudo-
system component to help satisfy downstream demands.

        Spill Controller: creates a pseudo-system component
that helps minimize reservoir spillages. 

        Hydropower: creates a powerplant (with variable or
fixed-head) for hydroelectric generation.

        Irrigation Water Supply: creates an offstream water
demand area of agricultural irrigation.

        Urban Water Supply: creates an offstream water demand
area for municipal and industrial water supply.

        Instream Recreation: creates a river reach with water
based recreation activities in the area.

        Storage Reservoir with Recreation: creates a storage
capacity with added lake recreation activities.

        Instream Flow Protection: creates a river reach
designated for fish/wildlife habitat protection.

        Flood Control: creates a river reach prone to overbank
flooding to assess possible damages.

        River Reach: creates a natural channel to convey flows
between system components.

        Canal/Pipeline: creates a water conveyance structure
such as a canal or pipeline.

        Left-bank Diversion: creates a diversion point for
diverting water over the left-bank. 

        Right-bank Diversion: creates a diversion point for
diverting water over the right-bank. 
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        Left-bank Junction: creates an inflow point to the
waterway from its left-bank. 

        Right-bank Junction: creates an inflow point to the
waterway from its right-bank.

Tools Palette 

The tools palette gives quick access to a group of functions that operate the WSCs. All tools are in
a palette that is automatically displayed on the left side of the screen. The user can move the tools
palette to any of the four sides of the screen. The tools palette can be removed from the screen by
disabling tools palette from the View menu. Choosing tools palette again returns it to its default
position. The icons, names, and functions of the tools are in table 7.2.

Table 7.2   The tools palette.
        Button Name and function

        Select: selects one or more system components from a flow
network.

        Move: moves a system component within the network worksheet.

        Rotate: rotates the direction of flow in a system component. 

        Delete: deletes a system component from the network worksheet.

        Physical Connectivity: displays categories of in/outflows from a
system component.

        Physical Input: accesses the physical data structure of a system
component.

        Economic Input: accesses the economic data structure of a system
component.

        Output Graph: accesses the list of output variables of a system
component.

        Graphical Folder: opens a folder that creates a list of variables for
output in graphical format.

        Tabular Folder: opens a folder that creates a list of variables for
output in tabular format (ASCII).
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        Select Output Variables: moves the output variables into the
Graphical /Tabular Folder.

Creating a Flow Network

The user interacts with the model through a graphical user interface to create a flow network. The
graphical user interface consists of the four elements of the model introduced earlier: i) the network
worksheet (NWS), ii) the menus, iii) the water system components (WSC) palette, and iv) the tools
palette.

In the NWS, each system component corresponds to a graphical node or link of the flow network.
The components are represented by icons in the WSC palette, based on a pictorial representation of
the component's function. By selecting (left clicking) an icon from the WSC palette and then left
clicking again in the NWS, the model creates an instance of the component. In this manner, all the
necessary components that simulate the topology of the actual river system are created. 

To assemble a flow network, place two or more nodes (water sources, reservoirs, powerplants,
demand areas, diversions, or junctions) in the NWS. Next, link the nodes using river reaches and/
or canal/pipelines, also selected from the WSC palette. Once a link is selected, place it in the NWS
by clicking first on an outgoing terminal of the upstream node and then on an incoming terminal of
the downstream node, always in that order. Additional nodes and links can be added to a network,
but links can only be placed between existing nodes.

There is no limit to the number of components that can be added to a network, but doing so increases
the mathematical dimension of the water allocation problem and the computation time needed to find
the optimal solution (see reference to computation times at the end of Chapter 8). In placing links,
the model prevents most absurd connections such as routing water released from a reservoir back
as an inflow to the same reservoir. Moreover, the model will automatically disallow connections that
are hydraulically unsound or not allowed by the model. 

Components can be moved anywhere in the NWS by clicking the Move button from the tools palette,
clicking on the component, and dragging and dropping it to its new position. A component can be
removed from the NWS by clicking the Delete button of the tools palette and then clicking on the
component in the NWS. Delete removes the icon from the screen and eliminates that instance of the
component from the model.

The creation and alteration of flow networks is expedited by copying and inserting portions of an
existing network onto the same or a new NWS. To do this, click the Select button of the tools palette
and select the part of the existing network to copy to the Windows clipboard. Select the desired part
by dragging a rubber-band box around it. The starting point is the upper-left corner of the box, which



7-7

Figure 7.3   Copy and paste of network components.

is anchored by left-clicking at the location. The box is enlarged by dragging the pointer to its final
position. The screen colors are reversed within the box (figure 7.3). To copy the information in the
box into the Windows clipboard, choose Copy WSC under the Edit menu. To place the information
from the clipboard to a NWS, select the command Paste WSC from the Edit menu and click at the
desired location within the NWS. The Paste WSC command is available whenever the Windows
clipboard has information that can be brought into a NWS.
Because Copy/Paste creates new instances in the NWS of the components stored on the clipboard

and duplicates their data structure, we call the duplicated objects clones. After pasting new
components in a NWS, amend the data associated with the new components if they require different
data from that brought in with the pasting operation. Information on the clipboard can be placed into
numerous worksheet locations as long as it remains in the clipboard. Copy/Paste also provides the
opportunity to build a library of individual components (e.g., reservoirs, irrigation areas) or small
networks, which can be easily incorporated onto a NWS when necessary. 
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Figure 7.4  Physical data input dialog box for a reservoir.

Entering Input Data 

The model uses physical and economic groups of input data. The physical data consist largely of the
dimensions and operational characteristics of the system components such as maximum reservoir
storage capacity, powerplant efficiency, the return flow coefficient from an irrigation zone. The
economic data consist mainly of the demand functions of the various water uses competing for water
within the river system. The input data entered for any system component is a property of the object,
even when stored on a disk for future use. When the network is reloaded from the disk to the NWS,
all data saved from the previous session for each component are retrieved in exactly the same form.

We recommend that every time a flow network has had its physical input data modified, particularly
when WSCs have been added or deleted, the new version of the network should be saved, closed and
reopened before any further analysis can take place.

Physical Input Data

Physical data are entered into the model using a series of dialog boxes specifically designed for each
system component. The data entry procedure is selected by clicking the Physical Input button from
the tools palette and clicking the component of interest. A data entry dialog box opens with multiple
tabs that group the input data by categories (as an example see figure 7.4). Table 7.3 lists the data
required for each system component.
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Table 7.3  Physical inputs for the following system components.

WSC Input Data Page of Reference

Surface Water .................................................................................................. 3-2
Physical Characteristics 

Name of river/basin
Input file name

 

Ground Water .................................................................................................. 3-2
Physical Characteristics  

Name of well or aquifer
Pumping Capacity

Monthly values ...
 

Storage Reservoir  ............................................................................................ 3-3, 5-14
Physical Characteristics  

Name of reservoir
Parameters of Elevation vs. Storage function
Parameters of Area vs. Storage function

Evaporation   
Monthly evaporation rates

Operational Characteristics   
Initial storage
Final storage
Minimum storage
Maximum storage

Operational Constraints (check-box) 
:  Minimum storage 
:  Maximum storage
:  Final storage 

Outlet Works 
Several entries ...

Release-to-downstream-demand  ...................................................................... 3-5 
Physical Characteristics  

Name of pseudo-object
Operational Characteristics   

Minimum flows ...
Maximum flows ...

Operational Constraints (check-box)  
9  Minimum flow 
9  Maximum flow

 

Spill Controller ................................................................................................ 3-6
Physical Characteristics  

Name 

Hydropower ..................................................................................................... 3-8, 5-14
Physical Characteristics  

Name of hydropower plant
Installed capacity
Design discharge
Turbine-generator efficiency
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Parameters of the Energy Rate vs. Storage function
Maintenance Schedule  

Monthly index of availability of the hydropower units ...
Maximum Release  

Monthly values ...
Minimum Release

Monthly values ...
Operational Constraints (check-box)

:  Minimum release
:  Maximum release

Irrigation Water Supply  ................................................................................... 3-11, 5-14
Physical Characteristics 

Name of irrigation area
Coefficient of return flow
Annual firm water 
Annual trend 

Maximum Flow 
Monthly values ... 

Minimum Flow 
Monthly values ... 

Seasonal Pattern
Monthly values ...

Operational Constraints (check-box)
9  Minimum flow
9  Maximum flow
9  Seasonal Pattern
9  Annual firm water

Urban Water Supply  ........................................................................................ 3-13, 5-14
Physical Characteristics  .

Name of municipal and industrial area
Coefficient of return flow
Annual firm water 
Annual trend 

Maximum Flow 
Seasonal values ...

Minimum Flow ... 
Seasonal values ...

Seasonal Pattern
Monthly values ...

Operational Constraints  (check-box)  
9  Minimum flow
9  Maximum flow
9  Seasonal pattern
9  Annual firm water

Instream Recreation ........................................................................................ 3-14, 5-14
Physical Characteristics 

Name of instream recreation area
Maximum Flow  

Monthly values ...
Minimum Flow  

Monthly values ... 
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Operational Constraints (check-box)  
9  Minimum flow
9  Maximum flow

Storage Reservoir with Recreation  ................................................................... 3-3, 3-17, 5-14
Physical Characteristics  

Name of reservoir
Parameters of Elevation vs. Storage function
Parameters of Area vs. Storage function

Evaporation   
Monthly evaporation rates

Operational Characteristics
Initial storage
Final storage
Minimum storage
Maximum storage
Minimum storage for recreation
Maximum storage for recreation

Operational Constraints (check-box) 
:  Minimum storage 
:  Maximum storage
:  Final storage 

Outlet Works  
Instream Flow Protection  ................................................................................ 3-17

Physical Characteristics 
Name of instream flow protection area

Maximum Flow 
Seasonal values ...

Minimum Flow 
Seasonal values ...

Operational Constraints (check-box) 
9  Minimum flow
9  Maximum flow

Flood Control  ................................................................................................. 3-19
Physical Characteristics 

Name of flood control area
Bankfull discharge 

Monthly values ...
River Reach  (no input data required) 
 

Canal/Pipeline  (no input data required) 
 

Diversion and Junction  (no input data required)  
 
Note: An option is enabled when a check mark appears in the check box; disabled when the check box is empty.
          Variables in shaded font are not available yet
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Economic Input Data

The economic data are the parameters necessary to specify the demand curves (i.e., the marginal
prices that users are willing to pay) for water during each season of the optimization horizon. The
data entry procedure is selected by clicking the Economic Input button from the tools palette and
clicking the object of interest. In some cases the user has the option to choose among exponential,
linear or constant prices, after which a data entry dialog box opens for user interaction (as an
example see figure 7.5). Table 7.4 lists the economic data required for each competing water use.

Table 7.4   Economic inputs for the following system components.

System Component Input Data Eq. of Reference

Hydropower Average annual and seasonal energy price: P, Ps ......................... (4.3)
Parameters of the seasonal demand function:  a2 , b2

Exponential decaying price ...................................... (4.3)
Constant price ......................................................... (4.10)

Irrigation Water Supply Parameters of the seasonal demand function:  a3 , b3
Exponential decaying price ...................................... (4.20)
Constant price ......................................................... (4.25)

Urban Water Supply Parameters of the seasonal demand function:  a4 , b4
Exponential decaying price ...................................... (4.28)
Constant price ......................................................... (4.33)

Instream Recreation Parameters of the seasonal demand function:  a5 , b5
Linear price ............................................................ (4.36)
Constant price ........................................................ (4.41)

Storage Reservoir Parameters of the seasonal demand function:  a6 , b6 , c6
with Recreation Hyperbolic tangent price ......................................... (4.44)

Flood Control Parameters of the flood damage curve:  a7 , b7  
Exponential increasing cost ..................................... (4.45)

Ground Water Parameter of the seasonal pumping supply function
Pumping Constant cost: a8   ................................................... (4.50)
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Figure 7.5  Economic data input dialog box for an irrigation area.

Network Connectivity

Once the flow network is assembled, the model conducts a series of validation steps before
proceeding to solve the water allocation problem. These procedures are launched by choosing the
command Update Network Connectivity from the Connectivity  menu.  Among the various validation
steps, the model checks that:
 T all WSCs are named;
T all WSCs that compete for water have marginal prices different from zero;
T instream water users (IRA, IFP, FCA) are placed in the flow network as such;
T offstream water uses (M&I, IRR, HPW) are placed in the flow network as such;
T  reservoirs have a waterway available for releasing uncontrolled spills (at the central terminal);
T  component connections are hydraulically sound.

Warning messages are displayed for violations of preestablished network connectivity rules. If all
steps are successfully completed, the network status changes from connectivity ..unchecked to
connectivity ..checked on the title bar of the NWS.
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System components competing for water are framed by a red line on the screen. Similarly, links
conveying controlled flows (i.e., links leaving a node where a decision is made) are turned red. The
number of sets of decision variables is equal to the number of red links. The WSC frame and the
links turn red after updating network connectivity.

An additional operation performed during this stage is defining the hydraulic connectivity of the
network objects. This information is used by the model to generate the mathematical connectivity
of the system components based on the requirements of the optimization technique selected. Details
on the mathematical connectivity of the system elements are found in Chapter 6.

If Names on Network is chosen from the View menu, next to each component in the NWS the model
displays the name assigned to the component by the user and the number assigned by the model to
links (i.e., river reaches and conveyance structures) and to diversion and junction nodes. The user
can also look at and print a table summarizing the network nodes (figure 7.6 top) and another one
summarizing network links (figure 7.6 bottom).  These tables are accessed by the commands List
Network Nodes and List Network Links in the Connectivity menu.

Selecting the Optimization Technique

Aquarius uses a sequential optimization technique, Sequential Quadratic Programming (SQP), for
solving the water allocation problem. Details of the algorithm are in Chapter 5. The algorithm is
(automatically) selected from the Techniques menu. This command opens a dialog box containing
a series of parameters, specified by the user, that control the sequential process and the accuracy of
the computations (figure 7.7). Parameters are divided into two groups, those that control the
sequential approximation algorithm, named Sequences Parameters, the purpose of each is:

Number of Sequences: this defines the maximum number of QP sequential problems to be solved (see Figure
5.1). The default for this parameter is 50, which is a reasonable number for a medium size networks
as the one presented in Chapter 8. 

Number of Sequences using : after an initial feasible solution is found,  are
specified to approximate the solution to a near-optimal level. The recommended value is between 1
and 5. The default value for any new run is set equal to 3.

Max. Number of Iterations per Sequence: this parameter is intrinsic to the general differential algorithm used
by QPTHOR to solve the QP problem. The user should explore values ranging from 5 to 50 iterations
per sequence. In general, the larger the value adopted, the smaller the number of sequences necessary
to reach the optimal solution.
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Figure 7.6  Table of network nodes and connectivity links.

And the Accuracy Parameters, to control the accuracy of the calculations. The purpose of each
parameter is:

Change of Objective-Value between Sequences: is the main stop criterion. Five consecutive solutions
(sequences) of the nonlinear problem with an objective function change less than the specified dollar
amount will cause the application to stop ($1000 in the example). 

Change of Objective-value Between Iterations: this is the stop criterion for each sequence of the differential
algorithm (QPTHOR), similar to the criterion above ($0.05 in the example).

Computational Accuracy Requirement: used extensively during optimization. A quantity is set equal to
zero when its value is less than its order of magnitude times a selected accuracy
(e.g., in the example).

Computational Accuracy for Evaporation: this parameter is used during the reconciliation procedure
implemented for the “Implicit” modeling of reservoir evaporation (0.0001 in the example).
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Figure 7.7  Control parameters dialog box.

The final solution to the water allocation problem found by the model is generally sensitive to the
values assigned to the parameters listed above. The proper values for the parameters will depend on
the topology of the network, the number of water users competing for water, and the length of the
optimization horizon. Given the difficulty of preestablishing the proper value for all these
parameters, the user should begin running the model with the default values and then experiment
with different values for the parameters to find the most appropriate set of numbers for the problem
at hand.

Specifying the Simulation Time Interval

The time interval for the analysis is specified by selecting the Uniform Time Intervals from the Time
Interval menu. This opens a submenu for selecting the periodic time interval:  Monthly, Weekly,
Daily. The monthly time interval is the only option active at the present (automatically selected).
Once the periodic time interval is selected, a window opens to enter the four items listed in the
dialog box in figure 7.8. Although the model was conceived to operate at any of the uniform time
steps offered in the menu (monthly, weekly, daily), present limitations in the graphical user
interfaces allow for only monthly time intervals.

The first entry in figure 7.8, Period of Analysis, specifies the length, in number of periods for which
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      Figure 7.8  Period of analysis and optimization 
horizon dialog box.

the model will determine the system
operation. Inflow data should be provided for
at least the same segment of time. The next
entry, Optimization Horizon, also in number
of time periods, specifies how far into future
the model should look to build the optimal
operational policies. The optimization horizon
defines the actual size of the optimization
problem(s) being solved. 

If the Optimization Horizon is set equal to the
Period of Analysis (Overlapping Period = 0)
, the quasi-continuous optimization scheme is
disabled (see Chapter 5, Time Intervals of
Analysis); hence, the optimal operational
policies identified by the model will extend
for the full number of periods indicated by the
optimization horizon. However, when the
period of analysis is longer than the
optimization horizon, which enables the
quasi-continuous optimization procedure, the user must also specify the number of Overlapping
Periods. The model allows the user to prescribe any number of overlapping periods for monthly
simulation.

The last input in the dialog box in figure 7.8, Starting Month, indicates the period within the annual
cycle for the start of the system operation. For instance, 1 for January, 2 for February, . . 12 for
December (for a monthly time step). In this manner, time series data, such as inflows, evaporation
rates, etc., are properly considered.

Solving the Water Allocation Problem

Once the network is assembled, including input of all the physical and economic data, and the
network connectivity is verified, Aquarius is ready to find the optimal water allocation. This is
accomplished by selecting the command Start Water Allocation from the Solve Network menu. 
The problem is solved in two steps. First, an initial feasible solution (IFS) to the water allocation
problem must be found. The IFS that the model finds will generally be far from the optimal solution
(see Chapter 5, Search for an Initial Feasible Solution), but serves as the starting point for the
sequential optimization procedure that follows. The IFS is obtained automatically by the model (the
search for an IFS is invisible to the user), and only for a network in the ..checked condition.
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      Figure 7.9 Selecting graphical display output
variables for a reservoir.

By specifying zero (0) number of sequences, the user can make the model to stop after finding the
IFS. The graphical output capabilities of the model, introduced next, can be used to render the state
of the system that corresponds to the IFS found by the model. 

The second step, actual optimization, consists of running the optimization algorithm to find the
optimal solution of the water allocation problem. As explained in Chapter 5, sequential algorithms
go through a succession of quadratic approximations of the nonlinear global objective function until
the optimal solution is reached. The maximum number of QP sequences allowed is indicated in the
corresponding dialog box (figure 7.7).  As the solutions of the QP problems progress, the status bar
at the bottom of the screen displays the sequence number. Once the optimal solution is found, or the
maximum number of sequences is reached, the optimization stops (indicated in the status bar). The
sequential optimization process can be interrupted by selecting Stop Water Allocation from the Solve
Network menu. The user can track the sequential changes in system state and decision variables
during the optimization by using the graphical output capabilities presented next.

Graphical and Tabular Output

Flow networks generally contain many state, decision, and economic variables that an analyst should
consider. Aquarius facilitates the interpretation and analysis of all information through readily
accessible graphical and tabular output display formats. The user can display output variables on the
screen by selecting Display Output Graphs from the Outputs Menu or by pressing the corresponding
icon in the tools palette and clicking on the
component of interest in the NWS. This opens
a dialog box that lists all physical and
economic output variables available for that
component. Figure 7.9 shows a dialog box for
a reservoir. A graph window is created when
a check mark is inserted (enabled) in the
corresponding check box and is deleted
(disabled) when the check box is empty.

If instead of clicking on a WSC in the NWS,
the user clicks any place in the worksheet, a
graph window opens showing the evolution of
the global objective function value as the
sequential algorithm (SQP) completes
optimization. This is possible because the
flow network as a whole is also an object.

Single-variable graph windows allow the user
to visualize the sequential changes in the
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state, decision, and economic output variables as the system reaches its optimal state. Visualizing
sequential changes is only possible if the output graph windows were opened either before launching
optimization or during the optimization.

Several graph windows can be open simultaneously, the only limitation is the number of windows
visible on the screen at one time. As they are opened, the graph windows appear on the screen in a
cascade format. The user may choose Tile from the Window menu to display all graph windows at
once. The model maintains a register of all graph windows opened during a working session. The
same graph windows can be reactivated any time by choosing Reactivate Screen Graphs from the
Outputs menu. The continuous refreshing of the graphical output windows after each sequence of
optimization increases slightly the execution time of the model. Table 7.5 presents the output
variables available for graphical display, listed by type of water system component.

Table 7.5  Output variables for the following system components
 

Surface Water 9  Natural Flows [Mcm]
  Ground Water 9  Pumping Flows [Mcm]

9  Pumping Cost [Mill.$]
 Storage Reservoir 9  Total inflows [Mcm]

9  Releases (up to 3 outlets) [Mcm]
9  Storage [Mcm]
9  Evaporation losses [Mcm]

 Hydropower 9  Powerplant releases [Mcm]
9  Plant generation [GWh]
9  Benefits [Mill.$]
9  Marginal prices [$/Mcm]

 Irrigation Water Supply 9  Allocated Flows [Mcm]
9  Return flows [Mcm]
9  Benefits [Mill.$]
9  Marginal Prices [$/Mcm]

 Urban Water Supply 9  Allocated Flows [Mcm]
9  Return flows [Mcm]
9  Benefits [Mill.$]
9  Marginal prices [$/Mcm]

 Instream Recreation 9  Instream flows [Mcm]
9  Benefits [Mill.$]
9  Marginal prices [$/Mcm]

 Storage Reservoir 9  Total inflows [Mcm]
with Recreation 9  Reservoir releases (up to 3 outlets) [Mcm]

9  Storage [Mcm]
9  Evaporation losses [Mcm]
9  Benefits [Mill.$]
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 9  Marginal prices [$/Mcm]
 Instream Flow Protection 9  Instream flows [Mcm]
 Flood Control 9   Flood discharge [Mcm]

9   Flows over bankfull discharge [Mcm]
9   Flood damages [Mill.$]
9   Marginal cost [$/Mcm]

 River System 9  Global Objective Function [Mill.$]
 

In addition to single-variable graphs, the user can create graphical and tabular outputs containing
one or more physical or economic variables. This is useful for displaying, in the same graph, output
variables of the same class generated at different locations in a flow network. For instance, the user
may want to compare energy generated at different powerplants, instream versus offstream water
allocations, or storage trajectories for all reservoirs. Similarly, this option can be used to generate
tabular outputs (in ASCII format) that can be printed or automatically imported into an Excel
spreadsheet. This is done by selecting Create Output Folder from the Outputs menu. This opens a
submenu from which to choose either a Graphical or a Tabular Output Folder. Folders can also be
opened from the tools palette. Both choices open a new window, the folder, that will list all output
variables. Once the folder window is visible, the procedure for selecting the variables starts by
clicking the Select Output Variables button of the tools palette and clicking the component of
interest in the NWS. This opens another window that lists all output variables for that specific
component (table 7.5 and figure 7.10). Select the output variables of interest by dragging each one
from the Select Output Variable window and dropping it into the Output Folder window (figure
7.10). Once all variables are selected, create an output product (i.e., graph or file) by clicking on the
Create Graph (File) button.



7-21

Figure 7.10  Specifying a list of variables for the tabular output folder.

In contrast to single-variable graph windows where information is updated during the sequential
optimization process, graphs and tables created by the output folder reflect the state of the system
at the moment the output is created (i.e., a static view). If only the optimal state of the network is
of interest, the output folder should be created after the water allocation finishes. Printouts of any
of the windows, including the NWS, can be obtained by making the window of interest the active
window and selecting Print from the File Menu. The Print command also provides most of the
customary Windows print settings.
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Chapter 8
Model Applications

This chapter presents two hypothetical river systems modeled at a monthly time step. The first, of
average complexity, is used to demonstrate various features of Aquarius, including the study of
alternative price functions for offstream and hydroelectric demands, and of the effect of
improving efficiency of irrigation water use. The second, of minimal complexity, is used to
illustrate the concept of economic efficiency that drives the water allocation.

Description of the River Basin System 

The first hypothetical river basin is represented by the flow network in figure 8.1, in which the
water flows from left to right. The basin comprises three water source subbasins, East Fork, West
Fork, and Lower Fork. Two of the subbasins are headwater catchments, at high elevations (left
portion of the graph). The third catchment area (Lower Fork) delivers unregulated inflows to the
downstream portion of the main water course. Inflows for a real case would typically be based on
flow data from the study site. Flows for this hypothetical river basin were taken from rivers of the
western United States. The long-term mean-annual discharges of the three catchments are 9,600
Mcm (East Fork), 6,700 Mcm (West Fork), and 6,500 Mcm (Lower Fork). The flow regime is
characterized by highly peaked hydrographs, typical of mountainous regions where runoff is
dominated by snowmelt. Flows are relatively low during the winter and very high during the
spring and early summer months (i.e., April through July).

The natural flows in are regulated by four reservoirs: East Lake, West Lake, Mid Lake, and
Lower Lake (figure 8.1). Table 8.1 lists the operational characteristics of the reservoirs. The
upper reservoirs (East and West Lakes) have relatively limited capacity to regulate inflows, with
active storage/inflow ratios of about 0.3. The third reservoir, Mid Lake, which impounds water
from the two upstream river forks, has a storage capacity equal to 70% of the mean-annual
discharge at that site. The most downstream reservoir also has limited capacity (storage to natural
inflow ratio equal to 0.26), but around 2/3 of its inflows are pre-regulated. When considering the
whole basin, the ratio of active storage to natural flows is approximately 1.0. 

Table 8.1  Operational characteristics of four hypothetical reservoirs.
  Reservoir       ------- Storage [Mcm] -------     Sto./Inf.        Elev. vs. Stor.        Area vs. Stor.         Constraints

           Min.        Max.     Init=Fin.      Ratio             c1          d1               c2         d2          Min. Max. Final
    East 2,000. 5,000. 3,500. 0.31 1.86 0.44 1.28 0.59 y y y
West 2,000. 4,000. 3,000. 0.30 2.77 0.48 0.26 0.75 y y y
Mid 6,000. 17,500. 14,000. 0.70 3.03 0.38 0.30 0.73 y y y
Lower 14,000. 20,000. 17,500. 0.26 0.79 0.44 1.00 0.68 y y y
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Thus, the system contains enough active storage to accommodate the total amount of water
generated by the three catchments during an average hydrologic year.

Table 8.1 also provides information about the elevation-storage and area-storage relations for the
four reservoirs (equations (3.4a) and (3.4b)). Monthly evaporation rates (which would typically,
in a real case, be estimated from data gathered at nearby meteorological stations) were set equal
to 30, 35, 40, 50, 65, 70, 85, 70, 60, 50, 40, and 35 mm/month, from January through December,
respectively for all reservoirs. Data pertinent to the spillways are set to zero (not used for
operation at monthly time intervals). The three operational constraints for reservoirs, minimum,
maximum, and final storage, are enforced according to table 8.1.

Hydropower is generated using releases from the four reservoirs. Due to existing topographical
conditions, the two high elevation reservoirs, East Lake and West Lake, are connected to run-of-
river powerplants, A and B, by canals that run parallel to the river at an almost constant
elevation. It is reasonable to assume that the two power facilities operate under fixed-head
conditions (see figure 3.4, right side). The remaining two powerplants, C and D, are located in
the intermediate and lower portions of the system, operate directly connected to the reservoir, and
are subject to variable hydraulic heads (see figure 3.4, left side). Table 8.2 describes the power
facilities.

Table 8.2  Characteristics of four hypothetical hydropower facilities.
             Installed     Design        Group    Scheduled    -- Energy Rate --         Plant Release      Constraints
Utility    Capacity   Discharge   Efficiency    Maint.          a1          b1             Min.    Max.        Min.  Max.

      [Mw]      [m3/s]           [ - ]                                [Mwh/Mcm]  [Mcm]
    Plant A 350920 0.90  no    97.15 0.00  100 2,400. yes yes
Plant B 300 600 0.90  no 164.13 0.00  100 1,600.  yes  yes
Plant C 450 800 0.90  no 163.76 0.04  100 2,100.  yes  yes
Plant D 250 1,600 0.90  no 89.66 0.02  250 4,200.  yes  yes
  

We assume uninterrupted service for maintenance or repairs of the generation groups (all
monthly coefficients are equal to one). Moreover, minimum powerplant releases (discharge per
month) are entered as indicated in table 8.2. Maximum releases are automatically computed by
the model from the specified powerplant design discharge and maintenance schedule coefficient
(by clicking the Reset button in the Maximum Releases dialog box). Maximum and minimum
powerplant releases are enforced in the formulation of the problem by enabling the corresponding
constraints in the Operational Constraint box.

Two separate outlet works in East Lake Dam control releases from the reservoir, one on each bank. The
left-bank reservoir outlet conveys water into the run-of-river hydroelectric Plant A. Characteristics of the
powerplant are in table 8.2. The right-bank outlet discharges into a canal that conveys water to the Upper
Valley agricultural area. Fifty percent of the irrigation withdrawals are assumed to return to the natural
channel via ground water accretion, far downstream from the dam. Minimum and maximum water
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Table 8.3  Offstream and instream demand areas for the hypothetical system.
   Demand   Monthly Demand   Return Flow     ------ Constraints ------ 
   Area           Min.       Max.     Coefficient       Min.  Max.  Seas. Firm

            [Mcm]           [ - ]
     Upper Valley 0 1,000.          0.5           no     no     no     no
 Mid Valley 0 2,000.          0.3           no     no     yes    no
 Big City 0 1,000.          0.0           no     no     yes    yes
 
 Native Fish var.     4,000.                yes    no      no    no
 Whitewater var. 4,000.                no     no      no    no
  

allocations for the Upper Valley zone are listed in table 8.3. However, all the operational constraints for the
Upper Valley demand area (minimum, maximum, seasonal and firm water) are disabled for this exercise. 

The central link extending downstream from East Lake reservoir (figure 8.1, link 27), represents
the natural riverbed. This portion of the river is assumed to have native fish species whose
populations have declined since reservoir construction, thus becoming an environmentally
sensitive area. Flow requirements were determined using a flow-habitat model as part of a fish
recovery program. The recommended mean-monthly flows for the fish habitat protection area
(figure 8.1, Native Fish) are 40, 40, 40, 60, 80, 120, 140, 100, 60, 40, 40, and 40 Mcm for the
months of January through December, respectively. The recommended minimum releases are
aimed at reestablishing some of the natural variability of the flow regime.

The West Lake reservoir regulates natural flows contributed by the West Fork subbasin. The
reservoir supplies water for the run-of-river Powerplant B, located on the right-bank of the river.
Characteristics of the plant are in table 8.2. The river reach downstream from West Lake but
upstream of the junction with the East Fork (Jct 6) is used extensively for recreational purposes,
mostly rafting and kayaking. This water use is represented in the flow network by the instream
Whitewater user (figure 8.1). Operation of the commercial recreational activities is from May
through September.

Regulated flows from the East and West Fork Rivers enter Mid Lake reservoir, where they are
regulated again. Releases from Mid Lake Dam are used to generate power at Plant C, which is a
variable-head powerplant. Characteristics of Plant C are in table 8.2. Turbine flows are returned
to the river at the toe of the dam. Further downstream, water is diverted to an irrigation demand
zone named the Mid Valley agricultural area. Thirty percent of the diverted water returns to the
stream (table 8.3), which implies a 70% consumptive use. Maximum and minimum diversion
channel capacity are indicated in table 8.3, though they are not enforced in the example.
However, whatever annual volume of water the model delivers to this region must match the
seasonal demand of the crops grown there, which is distributed among months January through
December as follows: 0.0, 0.0, 0.0, 0.05, 0.10, 0.15, 0.25, 0.25, 0.15, 0.05, 0.0, 0.0.
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Controlled releases from Mid Lake (minus Mid Valley consumptive use) and inflows from the
Lower Fork tributary enter Lower Lake. There are two controlled releases from Lower Lake
Dam: into Plant D, which is a variable-head powerplant (table 8.2), and into a canal that conveys
water to a municipal and industrial demand area named Big City. Big City is a transbasin
diversion from which no return flows are possible, as evidenced by the lack of a return link. Big
City has a firm contract for 7,000 Mcm per year, which implies that at least that amount of water
should be delivered every year. Moreover, the water to be delivered must match the following
seasonal distribution (from January through December): 0.07, 0.07, 0.075, 0.08, 0.09, 0.10, 0.10,
0.10, 0.09, 0.08, 0.075 0.07.

Figure 8.1 shows the names of the system components as entered by the user, and the numbers
assigned automatically by the model to links and nodes (shown only for junctions and
diversions). The model may randomly change the numbering of links and nodes every time the
connectivity of the network is checked. A change in the numbering of nodes and links implies a
possible change in the mathematical arrangement of the system components when the
optimization problem is formulated (Chapter 6, Mathematical Connectivity of System
Components). Slightly different optimal solutions should be expected from different
mathematical network arrangements due to limitations of numerical precision. Also, as
mentioned in Chapter 7, changes in the prescribed maximum number of iterations per QP
sequence and the value of the accuracy parameters may also cause slight changes in the final
optimal solution. 

Once network connectivity is updated (indicated by ...connectivity checked) at the top of figure
8.1), eight links turn from blue to red. Red links indicate the location in the network where
decision variables are created by the model to solve the water allocation problem. Similarly, red
lines framing eight water users indicate that they economically compete for water.

Defining Demand Functions

The demand functions used in this example reflect the general structure of prices in Chapter 4,
Benefit Functions. Monthly prices for energy are assumed equal for all months and for all power
facilities. This is a reasonable assumption considering that all powerplants sell their energy to the
same electrical grid system. Furthermore, downward slopping demand curves, equation (4.3),
reflect the difference in energy prices from on-peak to off-peak hours; the rate of decay is
constant for all months. Table 8.4 has information on hydropower economics.

The only instream user economically competing for water is the water-based recreation area
Whitewater. This highly seasonal activity, running from May through September, is represented
by linear demand functions, equation (4.25). The seasonality can be inferred from the values of
the coefficients of the price functions in table 8.5, which shows values different from zero only
for May through September.
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Table 8.4  Information on hydropower economics.
                        Avg. Energy Price         Price Function
                             P         Ps                  a2            b2             
Hydroplant           [$/MWh]               [$/MWh]                  
Plant A 30. 30. 46.75 1,712.
Plant B 30. 30. 46.75 2,085.
Plant C 30. 30. 46.75 2,917.
Plant D 30. 30. 46.75

800.
 

Price functions are seasonal for the
Upper Valley irrigation area (growing
seasons from April through October)
and seasonalness for Mid Valley. The
coefficients of the exponential
decreasing price functions, equation
(4.15), are shown in table 8.5. Prices
are equal to zero for the nonirrigation
months. For the transbasin urban
demand zone, Big City, prices also
decay exponentially with quantity
supplied, equation (4.20), although, in contrast to the agricultural zone, municipalities and
industries consume water all year around. This is indicated in table 8.5 by the nonzero values of
demand function coefficients for all months of the year.

Table 8.5  Economic information on instream and offstream demand areas.
                           Whitewater                 Upper Valley                   Mid Valley                   Big City        
Month               a5         b5                 a3          b3                  a3          b3               a4           b4   
                          [$/Mcm]                     [$/ Mcm]                          [$/Mcm]                    [$/Mcm]  
   Jan 0. 0. 0. 0. 0. 0. 38,700. 78.
 Feb 0. 0. 0. 0. 0. 0. 49,800. 92.
 Mar 0. 0. 0. 0. 0. 0. 65,200. 118.
 Apr 0. 0. 40,000. 662. 16,000. 485. 71,200. 134.
 May 2000. 2.0 40,000. 749. 16,000. 485. 76,000. 145.
 Jun 2000. 2.0 40,000. 814. 16,000. 485. 79,600. 155.
 Jul 2000. 2.0 40,000. 857. 16,000. 485. 85,000. 164.
 Aug 2000. 2.0 40,000. 890. 16,000. 485. 83,100. 160.
 Sep 2000. 2.0 40,000. 749. 16,000. 485. 73,400. 141.
 Oct 0. 0. 40,000. 543. 16,000. 485. 67,800. 115.
 Nov 0. 0. 0. 0. 0. 0. 56,700 88.
 Dec 0. 0. 0. 0. 0. 0. 41,500. 71.
 
Note: parameters b cannot assumed the value zero, hence enter a small number (e.g., b=1)

Finding an Efficient Water Allocation

This section describes the water allocation for the hypothetical river basin in figure 8.1 given the
water prices and operational constraints described earlier. The problem was solved over a two-
year period using monthly time intervals. The optimization horizon was also set equal to 24
months, making the quasi-continuous optimization procedure unnecessary. Because only a small
number of operational constraints was specified for the network, the model finds a water
allocation based mostly on the water value. After this baseline case is solved, conditions are
modified for different portions of the network to illustrate specific model capabilities.
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Initial Feasible Solution

The flow cascading algorithm (Chapter 5) provides the initial feasible solution (IFS) for this
problem. The approach consists of simply cascading flows through the reservoirs, avoiding
storage regulation when possible, and assigning water to instream and offstream users provided
that reservoirs' and water users' operational constraints are not violated. The analyst can force the
model to stop immediately after finding an IFS by entering “0” (zero) Number of Sequences in
the corresponding dialog box (see figure 7.7). Figure 8.2 displays some selected graphical
outputs, created by the model, that illustrate the state of the river-reservoir system after the IFS
was found. 

The storage trajectories for the reservoirs indicate constant reservoir levels for two of the four
reservoirs. Figure 8.2 shows monthly releases from East Lake Dam to Plant A, Rare Fish and
Upper Valley. The IFS algorithm satisfies minimum required flows at the Native Fish river reach
and then arbitrarily chooses any competing water user (Plant A in this example) to which to
allocate the remaining flows. For months in which the powerplant capacity was exceeded
(months 5, 6, and 16), the extra reservoir inflows were directed toward the Upper Valley
irrigation area. Reservoir evaporation is also satisfied. Release conditions from Mid Lake are
different from those at East Lake in that a single user (Plant C) is directly linked to the reservoir.
Because the maximum capacity of the powerplant is at times exceeded, the reservoir is forced to
regulate its inflows to avoid spillages.

When encountering offstream demand areas that claim water directly from the natural channel,
rather than from a storage reservoir as Upper Valley does, and when no minimum flows are
enforced, the IFS algorithm maintains water in the river rather than diverting it. Figure 8.2 shows
no water allocated to Mid Valley agricultural zone. Note that zero flows is a feasible solution
when seasonality is required.

The value of the total benefits from this arbitrary pattern of water allocation over two years of
operation was calculated by the model as $1,103.529 million. Although this initial solution is
feasible, it is far from being an efficient allocation of water, as demonstrated next. The set of
parameters chosen to control the optimization sequential process and the accuracy of the
computations for this example network coincide with those shown in figure 7.7. The water
allocation problem is solved using the “implicit” approach for modeling reservoir evaporation.
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Figure 8.2  Selected graphical outputs from the initial feasible solution.

Figure 8.3 Uncontrolled inflows and controlled outflows from West Lake.

Final Solution

A crucial element during the allocation process is the monotonic decrease in the marginal price
of allocated water with the increasing availability of flows. Reservoirs are also important
components during the allocation of water in the basin because flow regulation allows for
releases that efficiently satisfy instream and offstream demands. Figure 8.3 shows the high
contrast between the uncontrolled inflows and the controlled outflows from the West Lake
reservoir.
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Figure 8.4  Selected graphical outputs from the final optimization solution.

Figure 8.4 shows selected graphs of the result of the optimization. The two headwater reservoirs
absorb most of the variability of the natural inflows, creating favorable conditions for the rest of
the basin to generate hydropower and distribute water during the seasons in which it is needed.
Water levels in East and West Lake reservoirs oscillate from empty to full to avoid spilling the
large volumes of inflow associated with snowmelt. Because Plants A and B are run-of-river
plants (i.e., their energy generation is not a function of reservoir storage levels), they impose no
limitations in the oscillation of the water levels in the two headwater reservoirs. Contrarily, at
Mid Lake Dam, with a variable-head powerplant, almost constant and maximum water levels are
maintained during the whole optimization horizon to maximize hydropower production. High
reservoir levels are also maintained at Lower Lake, which besides receiving the regulated inflows
from the upstream portion of the basin, also captures uncontrolled inflows from Lower Fork
Basin, forcing an appreciable degree of regulation at the reservoir.
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Releases from East Lake are shown in figure 8.4 (upper-right graph, stacked bars). Water
diversions into the Upper Valley irrigation area (middle bars) display the classical seasonality of
irrigation demand, in this case controlled exclusively by the monthly price functions, since no
seasonality constraint was enforced for Upper Valley. Water is diverted during the growing
season, with zero flows during months outside the irrigation season (zero economic benefits for
those months, see table 8.5). Optimal releases for Plant A satisfy on-peak energy demand
throughout the entire optimization horizon, assigning extra releases (to generate lower value
energy) only during the first few months of every year. Link 27, the river reach where the fish
protection area was established, received no more flows than the ones enforced by the user via
the minimum flow constraint. This is expected since the optimization algorithm gives preference
for releases to users generating revenue, and Native Fish has no economic benefits attached to it.

Releases from West Lake, after passing through Plant B, become instream flows in the West
Fork River where the Whitewater recreation area is located. As indicated in figure 8.4, the model
releases relatively larger flows from West Dam during periods 5 through 8 and 17 through 20,
the months of economically valuable rafting and kayaking use. 

Optimal diversion for irrigation at Mid Valley also display the classical seasonal pattern, but this
time they are due to the enforcement of the seasonal pattern constraint (the price functions are all
equal). The volumes of water allocated each irrigation season are very similar but not identical,
with 30 percent of the diverted flow returning to the stream during the same month in which is
diverted (r=0.3).

Optimal releases from Lower Lake are displayed by the stacked bar diagram in the lower right-
graph of figure 8.4. The lower bars correspond to water supplied to the Big City M&I demand
area; the upper bars represent water released for hydropower to Plant D. Optimal flows allocated
to Big City follow the seasonal pattern indicated on page 137. Releases to Plant D tend to follow
the storage fluctuations in the reservoir, being small as the reservoir builds up storage and largest
during those months with the highest water levels at the reservoir.

Evaporation losses represent, on average, a relatively small amount of water when compared to
the total inflows to the reservoirs, 2.3% for headwater reservoirs and 3.8% for Lower Lake, but
with important monthly variations. Evaporation losses do not influence the storage patterns
significantly, thus justifying using the implicit model for reservoir evaporation. Moreover,
reservoir spills do not occur for the period of record analyzed in this exercise.

As illustrated in figure 5.1, the optimization algorithm SQP searches for the optimal allocation of
water by successively solving quadratic programming problems. Figure 8.5 shows the evolution
of the value of the global objective function as it progresses toward the optimal solution for this
example. There is a substantial improvement in the water allocation during the first few
sequences, accompanied by a drastic increase in revenues, followed by a relatively flat portion of
the revenue curve where only small changes occur during the remaining sequences. The search
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                  Figure 8.5  Evolution of the global objective function.

for the optimum stops when:
a) the maximum number of
sequences is reached (40 in this
example); b) the change of
global return between two
consecutive QP sequences
becomes less than $1000 (see
figure 7.7); or c) the solution
runs into some infeasibilities
(detected by the third accuracy
parameter in figure 7.7). In this
example network, the second
termination criterion stopped
the calculations at sequence
29. At this point, revenues for
the two-year period computed
by the model totaled $1,649.414 million.

If the third criterion stops the optimization, a
warning message alerts the user to either keep
the solution obtained that far, or consider
increasing the constraint infeasibility
accuracy parameter and resume the
optimization process. This situation may happen only when the implicit approach for modeling
reservoir evaporation is adopted.

Changes in Offstream Water Demand

We now introduce a change in the demand of water from an offstream zone to demonstrate how
the new problem can be solved with minimum computational effort, and discuss the implications
of the change. The allocation of water to the Upper Valley irrigation area for the baseline case
relied exclusively on the demand curves specified for each time period. Note that the optimal
allocation displays a seasonal variability consistent with the monthly demand functions in table
8.5 (see figure 8.4). We now assume that flows are also required for the nonirrigation month
January at Upper Valley. The new use will be incorporated into the model by altering the
economic conditions in the network rather than by imposing a minimum flow level constraint.
For the baseline case the demand function had null parameters for January (table 8.5); now they
are set equal to those for July (a3 =40,000 and b3 =857). The user can solve the new water
allocation problem by altering the marginal price of water at Upper Valley for January, validating
the network connectivity, and solving the optimization problem to find the efficient water
allocation policies under the new economic condition. 
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   Figure 8.6  Change in offstream water
demand.

However, because changes in the price structure do not invalidate feasibility in the network, the
user can proceed from the last optimal solution, in this case the baseline solution, to the new
optimal condition. Changes in marginal prices can be introduced any time during the execution
of the optimization or at the end of the sequences. If the change is introduced as the application is
executing, the graphical outputs will indicate how the model immediately starts redirecting the
allocation of water to accommodate the new economic conditions. If the change is introduced
after AQUARIUS has reached an optimum, the model will adopt the last optimal solution as the
IFS for the new round of optimization. For a minor change in price, the model will find the new
optimum very quickly. Figure 8.6
shows the results of the above
outlined procedure. The water
allocation at Upper Valley shows
positive flows for January (note that
months 1, 2, 3, 11 and 12 have zero
flow allocation in the baseline
solution, figure 8.4). The allocation
of flows to Upper Valley during
January reflects the willingness of
the irrigation area to compensate
other users for the extra water
demanded for that month. In other
words, a new potential Pareto
optimal arrangement was found.

As an additional example of a change in offstream water demand, consider an improvement in
irrigation efficiency, a change that can be characterized in terms of physical rather than economic
factors. Either by structural measures or conservation practices, the water duty for irrigation often
can be decreased. Although this may imply several modifications to the original baseline case,
we will simply increase the amount of return flow that originates from the Upper Valley
irrigation area from 0.5 to 0.7. This has practically the same effect on the network of reducing the
water duty, since more water will be left in the river for use by other system components
downstream.

After solving the network with the new Upper Valley return flow (note that when a physical
variable is changed a completely new run is required), the benefit from the network operation
increases from $1,649.414 million to $1,700.151 million, a $50.7 million (3.1%) change over the
two-year period. Additional information can be extracted to identify the downstream water uses
who benefit from this improved economic condition. The increase in benefit provides economic
incentive for negotiations among the multiple users in the basin to finance the structural
improvements necessary to conserve water in the basin.
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Figure 8.7  Hydropower releases with decreasing and constant energy price.

Change in Energy Price

Although unit revenues for hydroenergy are variable according to the type of energy being
generated, on-peak vs. off-peak (figure 4.2), some power systems are compensated economically
for the energy generated using a single rate, regardless of the time of the day in which the energy
is delivered. The purpose of this exercise is to demonstrate how this case can be modeled by
AQUARIUS and to show the operational consequences of such an assumption.

Within the AQUARIUS formulation, adopting a constant unit price for energy is equivalent to
replacing the exponential curve in equation (4.3) by the single step function (i.e., a constant value
for all plant utilization factors) in equation (4.31). Then, the value assigned to the parameter a2
will represent the constant rate paid for hydroenergy. A constant price specified by  a2 =15
$/Mwh was adopted for one of the powerplants, Plant D, while maintaining the rest of the
hypothetical system at levels of the baseline case described above. The system operation was
reoptimized under these new conditions. The values of the old and new powerplant releases from
Plant D are shown in figure 8.7.

The model for the exponential price function (left graph) shows power releases covering the on-
peak volumes for all time steps (since on-peak releases have a higher price) plus releases during
off-peak periods. When interpreting the series of releases from Plant D, remember that the upper
portion of the basin is holding most of its inflows during the first months to build up storage in
the reservoirs. In contrast, when the energy price function for Plant D is a constant (figure 8.7,
right graph), the powerplant is not compelled to satisfy on-peak releases as before. Although
power releases occur in a more random pattern, they contribute more to total system revenue,
which depends as well on other reservoir functions that encourage gains in storage whenever
possible to maximize the amount of energy generated with the same amount of water and to
satisfy the demand from Big City). Of course, this series of power releases would be
unacceptable in a real system where, typically, minimum power releases would be imposed to
ensure that a minimum amount of energy is generated each month (imposing such minimums is
also a viable option using AQUARIUS).
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Figure 8.8  Conditions of economic efficiency in water allocation.

Economic Efficiency for a Simple Case   

In this exercise, we use a simple flow network to illustrate the basic concept of economic
efficiency used in the model to drive the allocation of water in a river basin. This network
consists of a single reservoir with two offstream demand areas, The Farm and The City, which
withdraw water directly from the reservoir (figure 8.8, upper-left). The irrigation and urban zones
have completely different demands regarding the amount and seasonal distribution of water
required. The Farm receives water only during the growing season, April through October,
whereas The City receives water all year. Monthly price curves were provided for the two water
uses according to their seasonal demands. Furthermore, no minimum or maximum limits on
releases are enforced. The only constraints are upper and lower bounds on reservoir storage, set
equal to 5,000 and 2,000 Mcm, respectively, as indicated by the dashed lines in the upper right
graph of figure 8.8.
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Figure 8.8 shows the most significant outputs from the optimal solution: the reservoir storage
trajectory, the optimal releases, and the marginal prices of water for the two uses computed at the
point of optimality. As stated in Chapter 2, the model will allocate releases at a constant marginal
price, provided that an unbounded solution to the water allocation problem is obtained.

Figure 8.8 shows that the model reached the optimum when marginal prices were equalized for
the two demands (compare the two marginal price bar graphs). Once the optimal solution has
been reached, the value of water for each user, at the margin, is the same. This is not to say that
the optimally allocated flows are equal for the two users. In fact, one can observe that the two
users receive very different amounts of releases.

Under optimal conditions, the model keeps the marginal prices constant in time provided that the
solution of the problem is unbounded. Figure 8.8 shows that once the storage in the reservoir
reaches the upper or lower bound, the solution becomes bounded (i.e., it is no longer an interior
solution) and the marginal price changes. The solution of the reservoir problem is interior from
time period 1 through 6; thus, the marginal prices remain constant during those 6 months. Similar
behavior can be observed for other periods with interior solutions (e.g., 7-10, 12-17, 19-24). This
demonstrates, as discussed in Chapter 2, that the marginal benefit of the release remains constant
in time if the allocation is optimal.

Software Performance

The time of execution of an application depends on many factors. Among them are: the size of
the flow network (the number of decision sets); the topology of the network (the type of water
uses and how they interconnect); the number and type of operational constraints (whether the
problem is mostly constrained or unconstrained); the formulation selected for calculating
reservoir evaporation (implicit or explicit); the length of the period of study (including the period
of analysis, the optimization horizon and the overlapping period); the value of the parameters
controlling the QP sequential process (maximum number of QP sequences allowed and number
of iterations per sequence); the value of the parameters controlling accuracy (for general
calculations and for checking the feasibility of the solution); and the value of the parameters
controlling when to stop the optimization (minimum allowed change between consecutive values
of the objective function).

Definitively, the size of the flow network and the length of the period of analysis are the two
main factors determining the execution time. For a given network, the execution time increases
exponentially with the optimization horizon. For instance, the Example network is solved in 8
seconds for a 12 month optimization horizon, 57 seconds for 24 months, and 183 seconds for 36
months. The model was run in a personal computer with a 500 MHz Intel Pentium III processor
(the execution times do not include graphical output display between sequences).
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